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DO NOT USE THIS PRODUCT IN LIFE SUPPORT SYSTEMS.

LIFE SUPPORT POLICY

ZILOG’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE 
SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS PRIOR WRITTEN APPROVAL OF 
THE PRESIDENT AND GENERAL COUNSEL OF ZILOG CORPORATION. 

As used herein

Life support devices or systems are devices which (a) are intended for surgical implant into the body, or (b) 
support or sustain life and whose failure to perform when properly used in accordance with instructions for 
use provided in the labeling can be reasonably expected to result in a significant injury to the user. A criti-
cal component is any component in a life support device or system whose failure to perform can be reason-
ably expected to cause the failure of the life support device or system or to affect its safety or effectiveness.

Document Disclaimer

©2017 Zilog, Inc. All rights reserved. Information in this publication concerning the devices, applications, 
or technology described is intended to suggest possible uses and may be superseded. ZILOG, INC. DOES 
NOT ASSUME LIABILITY FOR OR PROVIDE A REPRESENTATION OF ACCURACY OF THE 
INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED IN THIS DOCUMENT. ZILOG ALSO 
DOES NOT ASSUME LIABILITY FOR INTELLECTUAL PROPERTY INFRINGEMENT RELATED 
IN ANY MANNER TO USE OF INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED 
HEREIN OR OTHERWISE. The information contained within this document has been verified according 
to the general principles of electrical and mechanical engineering. 

Z8, Z8 Encore!, and Z8 Encore! XP are trademarks or registered trademarks of Zilog, Inc. All other prod-
uct or service names are the property of their respective owners. 

Warning:
 UM028301-0317
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Revision History

Each instance in the Revision History table below reflects a change to this document from 
its previous version. For more details, click the appropriate links in the table.

Date
Revision 
Level Description Page

Mar 
2017

01 Original issue and applies to Development Kit Rev F or later and Zilog 
PCA 99C0918-001G Rev D or later.

n/a
UM028301-0317  Revision History
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Safeguards

The following precautions must be observed when working with the devices described in 
this document.

Always use a grounding strap to prevent damage resulting from electrostatic 
discharge (ESD).

Caution:
Safeguards  UM028301-0317
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The Z8 Encore! XP® F64XX Series 
Development Kit

Zilog’s Z8 Encore! XP® F64XX Series MCUs are a part of the line of Zilog® microcon-
troller products. 

The Z8 Encore! XP F64XX Series Development Kit (Z8F64200100KITG) allows you to 
get familiar with the hardware and software tools available with this product. This kit con-
sists of the 64 KB version of the Z8 Encore! XP Development Board that supports and 
presents the features of the Z8 Encore! XP F64XX Series. The software development tool 
kit allows you to write application software and contains all supporting documents.

Z8F6423FT020 is the silicon used in the board. For more details, refer to Z8 Encore! XP® 
F64XX Series Product Specification (PS0199) available for download at www.zilog.com.

This user manual acquaints you with the Z8 Encore! XP F64XX Series Development Kit, 
and provides instructions on setting up and using the tools to start building designs and 
applications.

This document provides instructions for setting up and configuring Z8F64XX Develop-
ment Board and includes schematic diagrams and a discussion of Board features and 
ZDS II.

The first sections of this document guide you through the following tasks:

• Download and Install the ZDS II Software and Documentation – see page 4

– Installing the USB SmartCable Driver – see Appendix B. Installing the USB 
SmartCable Driver on page 15

• Connect the F64XX Series Development Board to your PC – see page 5

• Start the Z8F64XX Demonstration Program – see page 6 

Further details, including memory configurations, jumper settings, and a listing of sample 
projects can be found in the Z8F64XX Sample Projects section on page 10. 

Figure 1 shows an image of the F64XX Series Development Kit.
UM028301-0317  The Z8 Encore! XP® F64XX Series Development Kit
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Figure 1. The F64XX Series Development Kit
The Z8 Encore! XP® F64XX Series Development Kit  UM028301-0317
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Kit Contents

Table 1 lists the contents of the F64XX Series Development Kit.

Kit Features

The key features of the F64XX Series Development Kit are:

• F64XX Series Development Board, which includes:

– Z8F6423FT020SG MCU in an 80-pin QFP package operating at 20 MHz

– UART0 port J4

– ADC Header J9

– Test points and headers

– Four LEDs (Power and Port Display)

– Two pushbuttons (Reset and Test)

– 20MHz Ceramic Resonator

– SmartCable Debug Interface J3 

• USB SmartCable

• ZDS II software, samples, and documentation available free for download

Supported Operating Systems

The F64XX Series Development Board supports the following operating systems:

• Microsoft Windows 7, 8, and 10 (32-bit/64-bit)

• Microsoft Windows XP Pro (SP3)

Table 1. Z8F64200100KITG Contents

Item Description Quantity

1 F64XX Series Development Board 1

2 USB SmartCable 1

3 6-circuit ribbon cable 1

4 A (male) to Mini-B USB cable 1

5 F64XX Series Development Kit Flyer (FL0174) 1
UM028301-0317  Kit Contents
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Download and Install the ZDS II Software and Documenta-
tion

Observe the following steps to install your ZDS II software and documentation.

If you have already installed ZDS II – Z8 Encore! <version> and have downloaded the soft-
ware and documentation by following the procedure on the paper insert in your kit 
(FL0174), you’re ready for Appendix B. Installing the USB SmartCable Driver on page 15.

1. Prior to connecting the Z8 Encore! XP F64XX Series Development Board to your 
development PC, download ZDS II for Z8 Encore! v5.2.2 (or later) from the Zilog 
Free Software category in the Zilog Store.

2. When your download is complete, unzip the file to your local drive, then double-click 
the installation file named ZDS2_Z8Encore!_<version>.exe, and follow the on-
screen instructions.

3. When the ZDS II installation is complete, double-click the installation file named 
DOCS_Z8Encore!_<version>.exe and follow the on-screen instructions.

Download and Install the Sample Project and Documenta-
tion

1. Download the Z8F64200100KITG Sample Project and Documentation <Version> 
from the Zilog Free Software category in the Zilog Store.

2. When the download is complete, unzip the file to your hard drive, then double-click 
the installation file named Z8F64200100KITG<version>.exe and follow the onscreen 
instructions.

3. When the installation is complete, view the Z8Encore! XP F64XX Series Dev Kit 
User Manual (UM0283, a PDF file); this document will be located in the following 
path, by default:

C:\Program files (x86)\Zilog\ZDSII-Z8Encore!_5.2.2\Docu-
mentation\Tools_Documentation

Note:
The Z8 Encore! XP® F64XX Series Development Kit  UM028301-0317
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Connect the F64XX Series Development Board to your PC

Observe the following procedure to connect the F64XX Series Development Board to 
your PC.

Disconnect or turn off the power to the F64XX Series Development Board before con-
necting or disconnecting the USB SmartCable.

1. Connect one end of the 6-circuit ribbon cable provided in your Kit to the USB Smart-
Cable unit, ensuring that the ribbon’s male connector is aligned correctly with the 
female connector on the unit, as indicated by the red stripe in Figure 2.

2. Connect the other end of the ribbon cable to Debug Connector J3 on the Development 
Board. Ensure that Pin 1 on the ribbon cable is aligned with Pin 1 on the target con-
nector, as highlighted in Figure 3.

Figure 2. Connecting the 6-Circuit Ribbon Cable to the USB SmartCable

Caution:
UM028301-0317  Connect the F64XX Series Development Board to 
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3. With the USB A (male) to Mini-B cable, connect Port P1 on the F64XX Series Devel-
opment Board to a USB port on the development PC to apply power to the Develop-
ment Board.

Start the Z8F64XX Demonstration Program

The F64XX Series Development Kit includes a sample program that demonstrates a blink-
ing LED application. An optional terminal emulation program and a 3rd Party USB to 
TTL Serial converter (not supplied) maybe used and must be configured for 57600-8-N-1 
with no flow control, as described in the HyperTerminal Configuration section on page 8. 
To get started with the Z8F64XX demonstration, observe the following procedure.

1. Launch ZDS II by navigating from the Windows Start menu to Programs → Zilog 
ZDS II – Z8 Encore! <version> → ZDS II – Z8 Encore! <version>.

Figure 3. Debug Connector J3
The Z8 Encore! XP® F64XX Series Development Kit  UM028301-0317
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2. From the File menu in ZDS II, select Open Project and navigate via the following 
filepath.

<ZDS Install>\samples\XP_F64XX\XP_F64XX_LedBlink\src

3. Select the ledblink.zdsproj project from within the src folder and click Open..

4. From the Build menu, select Set Active Configuration to open the Select Configura-
tion dialog box.

5. Select Debug, then click OK to close the Select Configuration dialog box.

6. From the Project menu in ZDS II, select Settings to open the Project Settings dialog 
box. In the Project Settings dialog box, click the Debugger tab.

7. On the Debugger page, select Z8F64200100KITG from the Target list, then select 
USB SmartCable from the Debug Tool drop-down menu, as shown in Figure 4.

Figure 4. Select Z8F64820100ZCOG and USB SmartCable
UM028301-0317  Start the Z8F64XX Demonstration Program
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8. Click OK to close the Project Settings dialog box.

9. If you are prompted to rebuild any affected files, click Yes. Otherwise, choose Build
from the menu bar, then click Rebuild All.

10. To run the application, select Go from the Debug menu. As a result, LEDs D3, D4, 
and D5 will blink in sequence.

11. After the application has started, UART0 output should be visible in the terminal 
application program, as shown in Figure 5.

HyperTerminal Configuration

A communications program such as HyperTerminal or TeraTerm can be used on Windows 
systems to view messages from the F64XX Series Development Board. The following 
procedure examines how to configure HyperTerminal for the Z8F64XX demonstration 
project.

The HyperTerminal application is not available in Windows 7 systems. If you are using either 
of these operating systems, consider using/installing different communication software such as 
Tera Term; see Appendix C. Tera Term Configuration on page 17.

Figure 5. UART Output Using Terminal Application program

Note:
The Z8 Encore! XP® F64XX Series Development Kit  UM028301-0317
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1. Connect a 3rd Party USB to TTL Serial converter to J20 on the Development Board
using the following connections. 

2. Connect the other end to your PC.

3. In HyperTerminal, choose File Properties then, if your PC has a serial interface, 
select the COM port assigned to your serial port. If you do not have a serial port on 
your PC, use a USB-to-serial adapter (not included in the kit). 

4. From the Windows Control Panel, navigate via the Device Manager to Ports (COM & 
LPT) to determine the correct COM port assigned to your adapter. Configure this port 
to reflect the following settings:

– 57600 bps 

– 8 data bits 

– No parity 

– 1 stop bit

– No flow control 

5. In HyperTerminal, click the Call button to connect to the F64XX Series Development 
Board. When connected, you should be able to see the demonstration program menu 
shown in Figure 5. 

ZDS II Flash Loader Utility

A Flash Loader utility can be accessed from the Tools menu in Zilog Developer Studio. 
With the Flash Loader, you can program the Z8F64XX MCU directly using the hex code 
generated from the ZDS II IDE; Figure 6 presents an example.

Table 2. USB to TTL Serial converter connection

Z8F64XX Board USB to TTL Serial Converter

J4-1 VCC 3.3V

J4-2 RXD TXD

J4-3 TXD RXD

J4-4 GND GND
UM028301-0317  ZDS II Flash Loader Utility
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Z8F64XX Sample Projects

A number of sample projects are included with the ZDS II – Z8 Encore! v5.2.2 software, 
which can be downloaded for free from the Zilog Store. These sample projects will be 
accessible upon installation of ZDS II – Z8 Encore! v5.2.2; their locations are listed in 
Table 3.

Figure 6. An Example Flash Loader Screen

Table 3. Z8F64XX MCU Sample Projects

Description Installed Location

ledblink \samples\XP_F64XX\XP_F64XX_LedBlink

\samples\XP_F64XX\XP_F64XX_LedBlink_asm
The Z8 Encore! XP® F64XX Series Development Kit  UM028301-0317
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F64XX Series Development Kit Documentation

The following documents are each associated to the F64XX Series of MCUs, and are 
available free for download from the Zilog website.

Table 4. F64XX Series Development Kit Documentation

Description
Document 
ID Installed Location

F64XX Series Product Specification PS0199 Documentation\Chip_Documentation

F64XX Series Product Brief PB0124 Documentation\Chip_Documentation

eZ8 CPU User Manual UM0128 Documentation\Chip_Documentation

Z8 Encore! XP F64XX Series API Program-
mer’s Reference Manual

RM0064 Documentation\Technical_Articles

Z8 Encore! Design for Debug TN0036 Documentation\Technical_Articles

F64XX Series Development Kit User Manual UM0283 Documentation\Tools_Documentation

Ethernet SmartCable User Manual UM0207 Documentation\Tools_Documentation

Opto-Isolated USB SmartCable User Manual UM0195 Documentation\Tools_Documentation

USB SmartCable User Manual UM0181 Documentation\Tools_Documentation
UM028301-0317  F64XX Series Development Kit Documentation

message URL http://www.zilog.com/docs/pb0124.pdf
message URL http://www.zilog.com/docs/um0283.pdf
http://www.zilog.com/docs/pb0124.pdf
http://www.zilog.com/docs/PB0124.pdf
http://www.zilog.com/docs/ps0299.pdf
http://www.zilog.com/docs/um0128.pdf
http://www.zilog.com/docs/z8encore/appnotes/tn0036.pdf
http://www.zilog.com/docs/devtools/UM0263.pdf
http://www.zilog.com/docs/devtools/UM0207.pdf
http://www.zilog.com/docs/z8encoremc/devtools/UM0195.pdf
http://www.zilog.com/docs/devtools/UM0181.pdf
http://www.zilog.com/docs/software/RM0064.pdf
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endix A. Schematic Diagrams
Figures 7 through 8 present schematic diagrams of the F64XX Series Development Board.



UM0283 Schematic Diagrams

® F64XX Series Development Kit
User Manual

13
01-0317

Z8 Encore! XP

Figure 7. F64XX Series Development Board Schematic Diagram, #1 of 2
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Figure 8. F64XX Series Development Board Schematic Diagram, #2 of 2
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Appendix B. Installing the USB 
SmartCable Driver

The USB SmartCable can be installed on PCs that run on Windows 7, 8, 10 (32- and 64-
bit), and Windows XP Pro operating systems. The procedures in this section will guide 
you through the USB SmartCable installation process.

Windows 7 32/64 Systems

Observe the following steps to install the USB SmartCable on a Windows 7 system.

1. Connect the USB SmartCable to a USB port on your development PC. When the PC 
detects the new hardware, it will display the Installing device driver software dialog.

2. Windows automatically searches for the driver; this process can take a few moments. 
Because there is no option to terminate this search process, wait for the search to com-
plete. If the driver was previously installed, Windows will automatically install the 
USB SmartCable driver. If this is the case, skip ahead to Step 9. If Windows cannot 
find the driver, close the search dialog and proceed to the next step.

3. In the Search programs and files field in the Windows Start menu, enter Device 
Manager. The Device Manager will appear in a list of search results.

4. From this list of results, click Device Manager to open the Device Manager dialog, 
which presents a list of devices that operate on your PC. Find and toggle Other 
devices to view a sublist of additional devices, and right-click your mouse on USB 
SmartCable.

5. In the submenu that appears, click Update Driver Software....

6. In the Update Driver Software – USB SmartCable dialog that appears, click the 
Browse my computer for driver software option.

7. Click the Browse... button to browse to one of the following driver directories, 
depending on the configuration of your PC.

On 32-bit Windows 7 systems, navigate to:

<ZDS II Installation Directory>\device drivers\USB\x32

On 64-bit Windows 7 systems, navigate to:

<ZDS II Installation Directory>\device drivers\USB\x64

8. Click Next to install the driver. On 32-bit Windows systems, a security dialog will 
appear; select Install this driver software anyway.

9. After the Wizard finishes the installation, click Close.
UM028301-0317  Installing the USB SmartCable Driver
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Windows XP Pro (SP3) Systems

Observe the following steps to install the USB SmartCable on a Windows XP system.

1. Connect the USB SmartCable to a USB port on the development PC. When the PC 
detects the new hardware, it will display the Found New Hardware Wizard dialog.

2. In the Wizard, select Install from a list or specific location (Advanced), then click 
Next.

If the Windows Hardware Installation dialog appears, click Continue Anyway.

3. In the Please choose your search and installations dialog, select Search for the 
best driver in these locations and include this location in search.

4. Use the Browse... button to navigate to one of the following paths:

<ZDS II Installation>\device drivers\USB\x32

5. Click Next to locate the appropriate driver.

6. Click Next a second time, then click Finish to complete the installation.

Note:
Installing the USB SmartCable Driver  UM028301-0317
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Appendix C. Tera Term Configuration
If you are using Tera Term as your console program, observe the following procedure to 
properly configure it.

1. Please refer to section HyperTerminal Configuration on page 8 on how to connect a 
USB to TTL serial converter between the development board and your host PC.

2. In Tera Term, and if your PC has a serial interface, navigate via the Setup menu to 
Serial port… to select the COM port assigned to your serial port. If you do not have a 
serial port on your PC, use a USB-to-serial adapter (not included in the kit). 

3. Use the Ports (COM & LPT) listing in the Device Manager to determine the correct 
COM port assigned to your adapter. Configure this port to reflect the following set-
tings:

– 57600 bps 

– 8 data bits 

– No parity 

– 1 stop bit

– No flow control 

4. Click the OK button to connect to the F64XX Development Board. Upon connection, 
you should be able to see the demonstration program menu shown in Figure 5 on 
page 8.
UM028301-0317  Tera Term Configuration
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Customer Support

To share comments, get your technical questions answered, or report issues you may be 
experiencing with our products, please visit Zilog’s Technical Support page at http://sup-
port.zilog.com.

To learn more about this product, find additional documentation, or to discover other fac-
ets about Zilog product offerings, please visit the Zilog Knowledge Base or consider par-
ticipating in the Zilog Forum.

This publication is subject to replacement by a later edition. To determine whether a later 
edition exists, please visit the Zilog website at http://www.zilog.com.
Customer Support  UM028301-0317
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